Description

Joint Modelling for
an RC Bridge with a
Drop-in Span

For LUSAS version: 21.0
For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.
With product option(s): | None

Description

A 3-span concrete bridge deck with a middle drop-in span is supported via bearings on
tapered piers. The example shows how to define and introduce joints to represent the
bearing support for the drop-in section, and the bearings required at the top of the piers.

Units used are kN, m, t, s, C throughout.

Objective

U To carry out design checks to a selected design code and confirm suitability for
steel member sizes.
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Keywords
3D, Deck, Pier, Bearings, Joints

Associated Files
Associated files can be downloaded from the user area of the LUSAS website.

U drop_in_span_bridge_preliminary.lvb creates the basic model
geometry. The example uses the model created by the file as a starting point.

Part 1: Modelling a joint-free model

| File

New...

Script >
Run Script...

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a New Model

o Enter a file name of drop_in_span_bridge

e Use the default User-defined working folder.
e Ensure an Analysis type of 3D is set.

e C(Click the OK button.

Note. There is no need to enter any other new model details when the intention is to
run a script to build an initial model, since the contents of the script will overwrite any
other settings made.

El To create the model required for this example, open the script file
drop_in_span_bridge preliminary.lvb that was downloaded and placed in a folder of
your choosing.




| File

Save

Running the analysis for the joint-free model

Groups have been defined for the features in the deck and the piers. These are required
to restrict the extent of data used to create graphs of results along the deck. The line
along the centre of the bridge is used when graphing results.

Save the model

El Save the model file.

Running the analysis for the joint-free model

&

With the model loaded:

il Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (& Treeview

Addition files will be created in the directory where the model file resides, including:

U Drop_in_span_bridge.out this output file contains details of model data,
assigned attributes and selected statistics of the analysis.

U Drop_in_span_bridge.mys this is the LUSAS results file which is loaded
automatically into the (E) Treeview to allow results processing to take place.

Viewing the results for the joint-free model

Analysis loadcase results are present in the (5 Treeview, and loadcase Dead load will
be automatically set active.




| Utilities
Graph Through
2D...

Joint Modelling for an RC Bridge with a Drop-in Span

e With no features selected, click the right-hand mouse button in a blank part of the

view window and select the Contours option to add the contours layer to the
Treeview.

e Select entity Force/Moment and component Mx and click OK.

This shows the moments present in the deck and piers when no joints have been
assigned to the model.

Graphing of moment along deck

A graph of bending moment Mx along the deck is to be produced. Graphing of data
along a selected line is to be used in this example. Other methods are available.

e First select the 2 N/A button at the bottom of the interface to view the model
along the z-axis (a plan view)

e Then select the line running along the centre of the bridge.
e Select the option By selected line and click OK.

e Define a graph for the Active loadcase and select Deck from the Extent droplist to
limit the graphed data to that set of elements and click Next.

Note. The option ‘Visible model’ cannot be chosen here because the slices that are
taken along the line running along the centre of the bridge would also include elements
that were in the piers, and an incorrect diagram would result.

e Select entity Force/Moment and component Mx and press Next.

o Enter a title of Mx along centreline and click Finish.




Viewing the results for the joint-free model
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By hovering the cursor over graph points of interest it can be seen that the peak
moment at the internal supports in 1092kNm and the lesser moment is 654kNm —
meaning that the pier is currently attracting a moment of 1092 — 654 = 438kNm.

Once a graph has been created, diagrams of graph locations can also be produced. This
has the benefit of seeing the results overlaid on the model.

e Close the graph window.

Viewing a bending moment diagram

e With no features selected, click the right-hand mouse button in a blank part of the

view window and select the Diagrams option to add the diagrams layer to the
Treeview.

e Select entity Force/Moment and component Mx and click OK.

o Select the |1 N/ button at the bottom of the interface to view the model along
the y-axis (from the side).

1 1

. ﬁl Use the dynamic zoom button to enlarge the left-hand pier and the ends of the
adjacent spans.
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From the updated diagram the previously described bending moments at the support
can be seen, and the moment at the intended drop-in slab bearing location is in the
order of 363kNm.

o Turn off the display of the Contours and Diagrams layers.

e Return the model to an appropriate isometric style of view.

Part 2: Modelling the bearings (joints) for a drop-in span

Defining the joints for the drop-in span
Define line mesh

To model the bearing strips for the drop-in span, a joint with no rotational stiffness is

used.
| Attributes e Select element type Joint no rotational | tinewesn &
|N|e§h— SﬁffneSS Analysis category
Line... ‘3[,

e Ensure assignment type is On single
feature (automatic)

Structural

@) Element description Use default spacing

Element type

e Enter a name of Bearing strip drop-in Lo T 2 i 5 R
Span and cl]ck OK' Assignment type
On single feature (automatic) ~ P
Spacing...
Element length
() Element name INT4 0.0

End conditions...

Name | Bearing strip drop-in span| v‘ < (new)

Cancel Apply Help

¢ In the model view window select the 6 lines that define the extent of the drop-in
span.




Part 2: Modelling the bearings (joints) for a drop-in span
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Assign mesh to model

e From the & Treeview drag and drop  Joint line assignment X
Bearing strip drop-in span onto the

Type of joint to create
selected features.

e Leave the type of joint to create as the
default Joints between surfaces (e.g.
hinge) and click OK. OJoints to isolate meshed

line
Note. Symbols representing the inserted
/ joints will not be seen immediately because

ZZZ
. L . [
the mesh is locked. This will be explained O Support ne via joints ===
after defining and assigning joint material to
the currently selected lines. Element orientation: ~ Global
Note. Because results were previously More >>
obtained and the model has now been edited, — Help

the View window will carry the wording
“Modification Mode” and “Results are out of date” until the model is solved again.

Define drop-in joint material

| Attributes e On the Joint material dialog select Spring Stiffness Only and click Next.

Material
Joint...




&

[Tools

Mesh >
Mesh Lock

Joint Modelling for an RC Bridge with a Drop-in Span

e On the Spring stiffness dialog define [eiostfnesen
the assignment as being for Lines A v

Assignment to | Lines -

Joint type |Joint no rotational stiffness -

e Select joint type Joint no rotational
stiffness

Properties specified for each freedom

u I v
Elastic spring stifness| 20e3 20e3

w [
3810e3 =

e FEnter a value of 20e3 for the u and v
freedoms and 3810e3 for the w
freedom.

o Enter the name as Bearing strip drop-
in joint and click Finish.

Name | Bearing strip drop-in joint ~ 2] rew)

< Back Next Ccancel Apply Help

Assign material to model

o With the lines representing the joint locations still selected, and from the &
Treeview, drag and drop the joint material Bearing strip drop-in joint onto the
selected features, clicking OK to assign to lines.

Note. Because results are currently available for the model prior to these joints being
applied the model’s mesh has been locked, so this needs to be unlocked to cause the
mesh to be re-created to include the joints. In doing so, the results file for the previous
model will need to be closed.

This unlocks the currently locked mesh and forces a re-mesh of the model, showing the
joints inserted at the bearing locations.

e Click OK to close the results files.




Running the analysis with drop-in span joints inserted

To see the effect of this change the model will be re-solved.

Running the analysis with drop-in span joints inserted

;l Select the Solve Now button from the toolbar and click OK to run the analysis.

Viewing the results with drop-in span joints inserted

e In the [=¥ Treeview turn on the display of the Contours and Diagrams layers to see
the results for entity Force/Moment Thick Shell and results component Mx.

o Select the |1 N/ button at the bottom of the interface to view the model along
the y-axis.

o L Sau S n s S

From the updated diagram it can be seen that the bending moment at the drop-in slab
bearing location is effectively zero as the joints don’t have any rotational stiffness.
There is a now a reduced amount of moment in the piers which will be investigated
next.

Note. Zooming-in on a model will generally show more value data, but in this case
/ the diagram values obtained at the supports will be more easily read by increasing the
scale of the diagram.

¢ In the &5 Treeview double click the Diagrams layer, select the Scale tab and use a
Local scale magnitude of 40 mm and click OK.




Joint Modelling for an RC Bridge with a Drop-in Span

1 B

From the updated diagram it can be seen that the pier itself is now attracting in the
order of 700 — 618 = 82kNm.

o Turn off the display of the Contours and Diagrams layers.

e Return the model to an appropriate isometric style of view.

Part 3: Modelling joints at the top of the piers

| Attributes

Mesh
Line...

Defining the bearings (joints) for the top of the piers

Define line mesh

To model the bearing strips at the top of the piers, a joint with no rotational stiffness is
also to be used.

e Select element type Joint no rotational stiffness
o Ensure assignment type is On single feature (automatic)
o Enter a name of Bearing strip for piers and click OK.

o Select the 2 surfaces representing the piers as shown below.
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Part 3: Modelling joints at the top of the piers

Clarify the features to be connected

Because the lines where the joints are to be inserted are shared between surfaces
representing the deck and the piers, selection memory must be used. Its use clarifies
between which higher order features (the surfaces) the line joints need to be added.

With the surfaces selected, right-click in the view window and choose Selection

Memory > Set

Click in an empty area of the view window to deselect the previously selected

surfaces.

Now select only the two lines representing the top of the piers.

il
)
....”..
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Assign mesh to model

e From the P Treeview drag and drop Bearing strip | ‘ointline assignment &
for piers onto the selected features. TR el
(@) b Siaces
(

.. . e.q hinge)
e Leave the type of joint to create as the default Joints e

between surfaces (e.g. hinge) and click OK.

Olnmts to isolate meshed
line

% 4

The View window will carry the wording “Modification
Mode” and “RCSultS are Out Of date” until the model iS OSuppnrtlmawajnmts
solved again.

3N}
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Element orientation: ~ Global

As explained previously, symbols representing the
inserted joints will not be seen immediately because the
mesh is currently locked. It will be unlocked after the = =
assignment of joint material.

More ==

Note. Whilst not required here, the use of the More >> button on the joint assignment
/ dialog provides other options to clarify how joint insertion should be done.

Joint line assignment X

Type of joint to create

T2 This option assumes that the line is not meshed @ By specified local coordinates

Joints between surfaces Global coordinates ~
©(EQ hiﬂgE] OJD\H(S between two

Sk () Follow axes of each volume

Ignore assigned local coords
Olﬂmts to isolate meshed O Follow axes of surface
line

Joints between two sets Ignore assigned local coords

(®)of surfaces (selection / (O Follow axes of line
memory dlarifies) £

() Support line via joints i [J1gnore assigned local coords
) By point in selection memory
Change joint orientation | Advanced
oK Cancel Help

Clear selection memory

Note that deck/pier joint material cannot be assigned when features are in selection
memory.

e Right-click in the view window and choose Selection memory > Clear

Define deck/pier joint material

| Attributes e On the Joint material dialog select Spring Stiffness Only and click Next.
| Material

|Joint...
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| Tools

Mesh >
Mesh Lock...

Part 3: Modelling joints at the top of the piers

e On the Spring stiffness dialog
define the assignment as being
for Lines

e Ensure the joint type is set as for
Joint no rotational stiffness

e Enter a value of 27e3 for the u
and v freedoms.

e FEnter a value of 4500e3 for the
w freedom.

o Enter the name as Bearing strip
for piers and click Finish.

Assign material to model

Spring Stiffness Only

Assignment to | Lines ~

Jaint type | Joint for beams hd

Properties specfied for each freedom

v [ w
P e I

u
Elastic spring stffness|  27e3

Name | Bearing strip for piers ~

<Back | Hewt- Cancel Apply

e Select the two lines representing the top of the piers.

2 (ren)

Help

e Drag and drop the joint material Bearing for piers from the &% Treeview onto the
selected features, assigning to lines and pressing OK.

Remove the mesh lock

This forces a re-mesh of the model, showing the joints inserted at the bearing locations.

e Click OK to close the results files.
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Running the analysis with top of pier joints inserted
With the model loaded:

;l Select the Solve Now button from the toolbar and click OK to run the analysis.

Viewing the results with top of pier joints inserted

e To see just the results for the deck, in the Treeview, right-click on the Deck
entry and choose Set as Only Visible

e In the Treeview turn on the display of the Contours layer to see the results for
entity Force/Moment Thick Shell and results component Mx.

o In the =" Treeview turn on the display of the Diagrams layer. Select the Scale tab
and use a Local scale magnitude of 40 mm and click OK to see the results for
entity Force/Moment Thick Shell and results component Mx

This shows that the moment along the lines of the bearings (joints) of the drop-in span
is zero as the joints don’t have any rotational stiffness.

o Select the |1 M button at the bottom of the interface to view the model along
the y-axis.

B BLLL T
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Viewing the results with top of pier joints inserted

From the updated diagram it can be seen that the bending moment at the top of the
piers is now 710 and the moment at the drop-in slab bearing locations is effectively
Zero

This completes the example.
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